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Chapter 1. Introduction  

Everyone who writes has a style, and an opinion about writing style. Sun Microsystems’  
style guide, Read Me First: A Style Guide for the Computer Industry, describes style and its 
importance in technical documentation:  

“If content is what we communicate, then style is how we communicate that content. Writing 
style is determined by all the decisions you make while creating a document, such as the type 
and tone of information you present, choice of words, language and format consistency, use 
of technical terms, and so forth…In the literary world, style is judged in part on artistic 
grounds, which may be highly subjective. In the field of technical documentation, however, 
experience and practice have provided objective criteria for evaluating style…” 

“Good style is synonymous with effective communication …” In technical documentation, 
the goal is not to show off the writer’s personal style. The goal is to communicate 
information to the reader. Because technical documents often have more than one writer, it is 
especially important that all writers on a project use the same style. This style guide will help 
you write in a manner that is consistent with good grammar and effective communication, 
and will help everyone have a common ‘voice.’  

This is not a writing handbook, nor is it a grammar guide. The items in this style guide 
address specific issues that have cropped up in our documents; some are ‘special requests’ 
from various project managers. For general style and grammar questions, refer to the 
Chicago Manual of Style, The Elements of Style, or Hodge’s Harbrace Handbook. (Where 
this guide differs from these three references, follow this guide.) If you need a guide to 
writing in general, Michael Bremer’s UnTechnical Writing is an excellent book, as is The 
Elements of Technical Writing by Gary Blake and Robert W. Bly. Online, you can check 
http://www.byteryte.nl/html/technical_writing.html and 
http://encarta.msn.com/column/questiongrammar.asp for more information.  

In all cases, client specifications override any other consideration. We should point out issues 
to the client, but we will follow the client’s final decision.  

Note about typing conventions: there are some key sequences described in this guide. Square 
brackets surround the letter or label of the key to be typed, as in this example: [h] means type 
the letter ‘h’ on the keyboard. When multiple characters appear together, you should type all 
the characters at the same time, as in this example: [Ctrl][Alt][Delete] means hold down the 
Control and Alt keys while pressing the Delete key.  
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Chapter 2. Before You Start Writing 

Before you actually start writing, there are some issues to consider: 

• Document template 

• Service request forms 

• Editing 

• Graphics 

• Reproduction 

• Audience 

Document Template 

The Compliance Business Unit has a basic Word template that governs the appearance of its 
documents. This style guide uses that template. It isn’t necessarily the be-all, end-all of 
document templates, but it can be a good place to start if you don’t have something else 
provided by a client. If nothing else, using this template saves you the trouble of building 
one, and it provides a common ‘look and feel’ to all documents that use it. You can request 
modifications, or ask for a completely different template that is custom-designed for your 
client.  

Whatever you do, use some kind of template. The styles alone are a great time-saver when it 
comes to formatting—or reformatting—a document.  

To obtain a copy of the latest Compliance template, contact a member of the editorial staff in 
Jacksonville at 904-288-8101. The template contains instructions on how to use the various 
styles.  

Service Request Forms 

Before work can start on a project, you must submit an Editorial Service Request form and/or 
a Graphics Service Request form to the Document Center Manager. The forms help the 
Document Center keep track of the job, and provide information needed to set up the files. 
The more information that you provide on the forms, the better the staff can meet your needs. 
The forms, designed to be completed electronically in Word and then e-mailed, contain 
check boxes, drop-down menus, and text fields. Illustrations appear below. The fields are 
indicated with shading.  
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 Before You Start Writing 

 

If you don’t understand the forms or what is required in a field, call the Document Center 
Manager for clarification.  

Editing 

If you intend to have the editorial staff go over your document, discuss your needs with the 
Document Center Manager as you build your working budget. There are various tasks that 
can be performed, from editing to proofreading to formatting, based on the project’s needs 
and the available budget. There is a certain amount of overlap between some of the tasks. 
Some tasks take significantly longer than others, so it’s important to discuss your needs with 
the Document Center Manager as soon as you can.  
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Substantive Editing 

Substantive editing is aimed at assisting the writer create the document. It looks at 
informational issues, rather than grammar and punctuation: 

• Logical flow and grouping of content  

• Unnecessary repetition 

• Appropriate tone and reading level for the intended audience 

• Necessity and appropriateness of graphics and tables 

• Usefulness and placement of headers and footers 

Copyediting 

Copyediting gets more into the ‘nuts and bolts’ of writing: 

• Logical flow of procedural steps and subsection headings  

• Internal consistency (use of terms, titles, acronyms, etc.)  

• Definition of acronyms on first use  

• Spelling, grammar, and punctuation 

• Internal consistency (references to headings, page numbers, figures, tables)  

• Placement of graphics and tables  

• Quality of graphics (print quality and readability)  

Proofreading 

Proofreading is like a preflight check, ensuring that certain things have been done correctly: 

• Spelling, grammar, and punctuation 

• Table and figure captions  

• Internal consistency (references to headings, page numbers, figures, tables) 

• List and procedure numbering  

• Line and page breaks  

• Page numbering  

• Consistency of formatting  

Proofreading is normally one of the final tasks performed on a document before it is printed 
and/or distributed electronically.  
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Formatting 

Formatting deals with the appearance of the document: 

• Page layout (margins, different first and odd/even headers/footers) 

• Insertion of header/footer information, if not already present  

• Application of appropriate styles 

• Insertion/resizing of graphics  

• Table (re)formatting  

Many of the tasks performed during formatting can be handled by starting from a template 
and using of styles appropriately while writing.  

Generating Front and Back Matter 

These parts of the document are created after the writing is done, although some may be done 
concurrently with the writing: 

• Table of contents 

• List of figures 

• List of tables 

• Acronym list 

• Index 

• Word bookmarks (for cross- and page references) 

“Standard Edit” 

If nothing else is specified, these are the specific tasks that the editors perform on every 
document: 

• Perform proofreading tasks. 

• Flag (but not correct) logic problems, such as procedural steps that are out of order or 
headings that don’t reflect the text below them. 

• Flag text where meaning is unclear. 

• Generate TOC from finished document (allow extra time if the TOC has to be created 
by hand rather than generated from Word styles). 

• Supply general comments, including apparent reading level.  

The editorial staff averages 8-10 pages per hour to perform these tasks, but that varies 
depending on the general condition of the document when it comes in.  
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Graphics 

Good graphics can help explain your topic; bad graphics get in the way of understanding. 
Rather than drawing or searching for graphics that may be inconsistent in style or unsuitable 
for printing, use the graphic artist in the Document Center so as to save your time for 
developing the technical content. The graphic artist can provide a variety of services: 

• Scan forms & photos.  

• Edit/retouch photos. 

• Recreate forms in .EPS. 

• Re-draw site maps for plans. 

• Create original hand-drawn graphics. 

• Draw illustrations (such as underground oil/water separators, ASTs, etc.). 

• Design PowerPoint presentations. 

• Design Web pages. 

• Create animated graphics for PowerPoint presentation or Web pages. 

• Create interactive CD-ROMs using Flash or Director. 

• Design CD labels/jewel cases. 

• Design covers for plans/manuals. 

• Design & lay out brochures and other documents. 

• Create logos/letterhead/business cards. 

Contact the Document Center Manager to discuss your needs. 

Reproduction 

Document reproduction can be handled by project managers in several ways. The preferred 
choice is to send it to the Tulsa office, which has in-house repro capabilities, as well as a 
relationship with an outside printer for large print runs or lamination. In Jacksonville, 
printing is outsourced to Kinko’s at negotiated rates. You can also handle repro at your own 
location by any means suitable. If you choose to handle it yourself, and you intend to use a 
local Kinko’s but don’t have special rates, please contact the Document Center Manager, 
who will work with the Jacksonville Kinko’s manager to see if your local Kinko’s office will 
honor the negotiated rates.  

The Editorial Service Request form has several fields related to document reproduction. No 
matter who is handling repro, the editorial staff needs that information. It affects how the 
Word file gets set up and handled. Please provide the requested information. 
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Audience 

Determine the audience and reading level before you start writing. The reading level of the 
average shop mechanic is not the same as the average officer, whose reading level is not the 
same as the average scientist. If the audience is mixed—for example, a combination of shop, 
administrative, and scientific personnel—aim for an 8th grade reading level. Remember, no 
one ever complained that a document was too easy to read.  

Be aware that reading level is determined more by sentence structure than by vocabulary. 
Use the necessary technical words, defining them where necessary, with simple, 
straightforward sentence structure. See “Simple Sentences” in Chapter 3. 
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Chapter 3. While You’re Writing 

This section addresses common issues in company documents. 

Simple Sentences 

The simple sentence is the most basic sentence. It is an independent clause that contains a 
subject and verb, possibly with a direct object: 

He works. (subject and verb) 

She carried the box. (subject, verb, and direct object) 

Although your topic material may be a little more involved than this, that doesn’t mean your 
sentence structure has to be. Always construct sentences as simply as possible. Short, direct 
sentences communicate more clearly. Avoid tacking on extra clauses that may get in the way 
of information transfer.  

Sentence Function 

In English, sentences have four functions: 

• Declarative sentences make statements: PCBs are hazardous.  

• Imperative sentences give commands or make requests: Close the valve.  

• Interrogative sentences ask questions: Are all hazardous materials labeled correctly?  

• Exclamatory sentences make exclamations: Don’t exceed the container’s capacity!  

Declarative sentences are the most common type of sentence in company documents. They 
can be written in first, second, or third person.  

An imperative sentence can only be written in second person. The word you is normally 
implied rather than expressed. When you use the imperative, you speak directly to the reader. 
This can be especially important when writing procedural material.  

As much as possible, be consistent in who you address in a document. Switching between 
second and third person can confuse readers and leave them wondering who is supposed to 
do what. You can avoid this problem by considering both the topic material and the audience 
before you start writing. For example, a report for managers can usually be written in third 
person throughout because it’s reporting facts, not giving instruction. A procedural manual 
aimed at a specific type of technician could—and possibly should—be written in second 
person throughout because it’s giving direction/instruction.  

Do not use exclamatory sentences in company documents.  
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Active Voice 

In general, it’s better to use active voice in your documents. As defined in Hodge’s Harbrace 
Manual, active voice “emphasizes the subject as the doer of the action.” If the verb in your 
sentence has some form of the verb be attached, the sentence is in passive voice, not active.  

Active voice is more direct, more precise, and more concise. It also assigns responsibility for 
the action. Here are examples of active and passive voice: 

Active: If there is an emergency release, the EPS must notify outside agencies.  

Passive: If there is an emergency release, outside agencies must be notified by the EPS.  

The active-voice sentence puts the emphasis on who makes the call. The passive-voice 
sentence puts the emphasis on the receiver of the call.  

Here is another pair of sentences: 

Active: Pack used batteries in a cardboard box.  

Passive: Used batteries must be packed in a cardboard box.  

The active-voice sentence, which is also written in the imperative, gives direction. The writer 
is speaking directly to the reader, who will understand that he or she is the person who is 
supposed to perform the action. The passive-voice sentence states a requirement. It doesn’t 
tell who is responsible for performing the action.  

The table below compares active and passive verbs/verb phrases: 
 

Active Passive 
Refer to Make reference to 

Determine Make a determination 

Consider Take under consideration 

Applies to  Is applicable to 

The active examples are much more direct, and use fewer words. As much as possible, use 
active voice, especially when giving direction or instruction. However, in cases where the 
action is more important than who performs it (for example, a list of requirements), passive 
voice is acceptable.  
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Acronyms 

In order to be sure that all the readers know what you mean, you must define acronyms on 
their first appearance in the text of a document, even though there may be an acronym list in 
the document.  

If the first use of an acronym is in a table, define it there but also define it the first time it 
appears in the body text. Define acronyms separately in a preface or an appendix, as well. 
Never define an acronym in a heading.  

Once you’ve defined the acronym, use it. Don’t redefine it repeatedly throughout the 
document/chapter/page. However, if you define and use an acronym in the document’s first 
chapter but then don’t use it again until several chapters later, and the acronym is not one that 
will be commonly known by the reading audience, it’s appropriate to define it a second time 
as a reminder.   

Don’t define an acronym if it will never be used in the document.   

Just because the acronym is in all caps doesn’t necessarily mean that the phrase it’s derived 
from has to appear in title caps. Compare: Hazardous Chemical Management Plan (HCMP) 
vs. hazardous waste (HW).   

Use all caps for government agency acronyms (for example, DOD, not DoD) unless your 
client specifies otherwise.  

The company’s Infonet has a list of acronyms (click the Library link), but if you can’t find 
what you’re looking for there, try online at http://www.acronymfinder.com.   

Special note: SOP usually stands for standard operating procedure. However, the US Army 
uses it to mean standing operating procedure. Check with your client to find out which 
meaning they use and then define the acronym appropriately. 

Consistency of Verb Tenses  

Verb tense indicates when actions take place. Past tense forms indicate the action has already 
happened. Present tense forms indicate that is happening now. Future tense forms indicate 
that it will happen later. Use verb tenses that accurately reflect when the actions took—or 
will take—place. Otherwise, the reader is forced to discern this from context, and may end up 
confused.  
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Notes, Cautions, and Warnings 

Note, Caution, and Warning are trigger words that indicate a required level of attention on 
the part of the reader. The explanations below are displayed in the actual style from the 
Compliance template.  

Note Note signifies that the text is nice-to-know information that amplifies the previous 
text, but it won’t make any difference if the reader skips it. If the information is too 
important to skip, it isn't a note.   

 

Caution Caution signifies that the reader should pay attention to this text because there is a 
risk of property damage.   

 

WARNING Warning signifies that the reader should pay attention to this text because there is 
a risk of injury or death.   

In situations that involve flammable, reactive, and/or explosive materials, always use the 
trigger word Warning. 

Items in Series 

Be very careful with items in series. If you use a series as the subject or object of a single 
verb, the verb must apply appropriately to each item. To verify this, write the sentence using 
each item by itself. Example: 

The truck is diesel-powered, painted green, and has six wheels.  

The truck is diesel-powered. 

The truck is painted green. 

The truck is has six wheels.  

The third item in the series had its own verb, so it wasn’t the same as the other items and it 
doesn’t work with the sentence’s verb. The example below shows how to rewrite the 
sentence: 

The truck is diesel-powered and painted green. It has six wheels.  

For punctuation in a series, see the section “Punctuation” below.  
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Punctuation 

This section addresses specific issues encountered in company documents. 

End sentences with a period or a question mark, as appropriate. Follow that punctuation with 
only one space.   

When introducing a list, end the complete sentence of introduction—the stem sentence—with 
a colon. (See the sample list shown under the series punctuation rules below and “Bulleted 
Lists” on page 19.) 

In bullets, end complete sentences with a period or question mark, as appropriate. Use no 
punctuation at the end of phrases. Avoid mixing sentences and phrases in the same list.*  
First-level bullets and second-level bullets can be of different types, but be consistent within 
a level. (See “Bulleted Lists” on page 19.) 

When writing a series, use a comma following the item before and or or as shown in the 
example: 

When handling battery acid, you need proper PPE such as gloves, boots, and an apron.  

If a series contains items that have internal punctuation—such as phrases with commas—
separate the items with semicolons as shown in the example: 

You can choose from the fruit plate with melon, pineapple, and cottage cheese; the salad 
plate with iceberg lettuce, Roma tomatoes, red onions, and no dressing; or the cereal 
special with granola and unflavored yogurt.  

However, it’s better not to write sentences like this because they can be more difficult to read 
and understand. If you can’t rewrite the information as several sentences, consider presenting 
it as a bulleted/numbered list as shown in the example:  

These are your choices: 

• The fruit plate with melon, pineapple, and cottage cheese 

• The salad plate with iceberg lettuce, Roma tomatoes, red onions, and no dressing 

• The cereal special with granola and unflavored yogurt 

Do not use semicolons to join sentences or phrases. Write two separate sentences.  

                                                 

* If it’s unavoidable, use punctuation after all items in the list. Note that it’s nearly always possible to avoid 
mixing phrases & sentences.  
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Apostrophes are used in contractions and to show possession. Examples: 

that is = that’s     did not = didn’t     it is = it’s     was not = wasn’t  

the car belonging to the major = the major’s car  

the hazardous waste plan belonging to the facility = the facility’s hazardous waste plan  

One notable exception: the possessive form of “it” is its, without an apostrophe.  

When typing phrases that include words and numbers—chapter names, regulations, laws, 
etc.—use non-breaking hyphens or spaces to ensure that the phrase doesn’t break across the 
end of a line or page. Here are some examples of phrases that need non-breaking 
hyphens/spaces: 

Chapter 11, AR 200-1, 40 CFR 129 

To type a non-breaking hyphen, type [Control][Shift][-] (hold down the Shift and Control 
keys and press the hyphen key, similar to the way you type [Control][Alt][Delete]). To type a 
non-breaking space, type [Control][Shift][space bar].  

Type telephone numbers without parentheses, as shown below: 

904-288-8101 

Use non-breaking hyphens to ensure that the digits are always on the same line. If there is an 
extension for the number, type it as shown below and use non-breaking spaces to keep it with 
the telephone number: 

904-288-8101, extension 102 

If desired, abbreviate extension as ext. but be consistent throughout the document. If the 
sentence continues after the extension, put a comma after the extension number.  

When typing addresses, do not put a comma between the city name and the two-letter postal 
code for the state. Use a comma only when writing out the full state name, or when using 
abbreviations such as Fla., Calif., etc.  

En-dashes and em-dashes serve specific purposes. The en-dash is slightly wider than a 
hyphen. Use it when writing ranges of numbers or dates, as shown below: 

1975–1982, pages 32–57 

To type an en-dash, hold down the Alt key while typing 0150 on the keypad. After you type 
the numbers, let go of the Alt key. The en-dash will appear. 
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The em-dash is roughly three times as wide as the hyphen. Use it to set off parenthetical text, 
such as quick examples or ‘asides.’ The em-dash appears in several places in this document, 
as in the example below: 

Use verb tenses that accurately reflect when the actions took—or will take—place. 

To type an em-dash, use Alt code 0151.  

Refer to Hodge’s Harbrace Manual for general punctuation questions.  

Hyphenation 

Do not use hyphenation to “break” words at the end of a line in company documents. Doing 
so can make documents more difficult to read.  

Phrases used as adjectives need hyphens between the individual words. Example: 

Some tanks are built with double walls. (no hyphen; double describes walls) 

Double-walled tanks are more expensive. (hyphenated; double-walled is a phrase that 
describes tanks) 

For guidance on specific phrases, see “Problem Words” on page 24. For use of non-breaking 
hyphens, see “Punctuation” on page 15.  

Latin Phrases 

Certain Latin phrases, or their abbreviations—i.e., e.g. , and etc.—are common in many types 
of writing. Because many writers use i.e. and e.g. inappropriately, and because not all readers 
know what they mean, do not use them in company documents. If you are giving an example, 
use the phrases for example or such as. Keep the use of etc. to a minimum.  

Capitalization 

“To capitalize” means to make uppercase the first letter of a word. In general, capitalize the 
first word of a sentence, the first word of a bullet item, proper names, trade names (but not 
common nouns that follow them, as in Portland cement), and academic degrees and honors 
that follow a person’s name. Additional note on academic degrees: use B.Sc.—not B.S. or 
BS—as the abbreviation for Bachelor of Science 

In soil science, capitalize the 24 soil classifications (for example, Alpine Meadow) when the 
names are used as such, but not in normal speech (for example, Switzerland has many 
beautiful alpine meadows).  
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In zoology and botany, capitalize phylum, class, order, family, and genus names. Do not 
capitalize species names.  

Capitalize titles of acts and laws, but not the common element (for example, act, law, etc.) 
when it used in place of the full name.  

Capitalize the titles of books, magazines, and other documents, but do not capitalize a 
common word that is used alone on subsequent references. Example: “The Colorado Army 
National Guard Hazardous Material & Hazardous Waste Plan (COARNG HM&HWMP) 
was produced by e²M. The plan explains how to handle hazardous materials and hazardous 
waste commonly found at COARNG work sites.” 

Capitalize the names of geological eras, periods, epochs, etc., but not the words era, period, 
epoch, etc. Examples: Cenozoic era, Tertiary period, Pliocene epoch. Do not capitalize 
modifiers such as early, middle, and lower.  

Capitalize words that are part of the official designation of a country or territory, but do not 
capitalize the same words when used generically or with a different meaning. Examples 
follow: 

United States, but the 50 states or foreign states; a country united  

United Kingdom, but a small kingdom  

Northwest Territories, but the territory of American Samoa 

Cherokee Nation, but a peaceful nation or a foreign nation  

Do not capitalize school, company, department, federal, state, local, or tribal unless they 
begin a sentence or are part of a proper name. Example: the Department of Health and 
Human Services, but HHS is a department of the government.  

Do not capitalize military ranks unless they begin a sentence or are part of a proper name 
(except General of the Army and Fleet Admiral; as part of the signature line of 
correspondence; and when used in direct address, as in “Good morning, General.”).  

Do not capitalize elective titles unless they begin a sentence or are part of a proper name 
(except the Speaker of the House, who is referred to as the Speaker; as part of the signature 
line of correspondence; and when used in direct address, as in “Good afternoon, Senator.”). 
Example: President Bush, but the president is George W. Bush. 

Do not capitalize work titles (for example, supervisor, engineer, manager, etc.) unless they 
begin a sentence (except as part of the signature line in correspondence).  

Do not capitalize directions when used generically (for example, east, south, northern, 
westerly, but Northern Ireland, the Midwest, the Pacific Northwest, South America). See the 
Chicago Manual of Style for more examples.  
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Do not capitalize geographical/topographical descriptors (for example, lake, bar, peninsula, 
valley, etc.) except when they are part of a proper name, such as Lake Superior or Red River 
Valley. 

Bulleted Lists 

Bulleted lists are used to present list material when the order of presentation doesn’t matter. 
Bulleted lists must be preceded by a stem sentence. Example: 

These information sources can help you identify wastes: 

• DRMO database information 

• Hazardous waste manifests 

• Solid waste disposal records 

In a stem sentence, the colon serves the same purpose as a period. That means that the 
sentence must be complete before it gets to the colon. Do not put a subject and verb before 
the colon and then use the bullet items as direct objects that will complete the sentence, with 
punctuation that makes it appear that the items are part of a ‘flat’ sentence, as shown below: 

To identify wastes, refer to: 

• DRMO database information; 

• Hazardous waste manifests; and 

• Solid waste disposal records.  

The items in a bulleted list can be individual items, phrases, or sentences. Always use initial 
caps for the list items. Do not use title caps unless the items are proper names, such as book 
titles, personal names, or something similar.  

The list items should all be of the same type. Do not mix phrases and sentences. Do not mix 
object (nouns and noun phrases) and action items (verb phrases and ‘take-action’ sentences) 
in a list. The example for stem sentences is a good example of a list of objects. Here’s a bad 
example that mixes nouns and verbs, as well as phrases and sentences: 

These information sources can help you identify wastes: 

• DRMO database information <-- phrase; object 

• Hazardous waste manifests <-- phrase; object 

• Solid waste disposal records <-- phrase; object 

• Check air emissions inventories.  <-- sentence; action 

Punctuation in bulleted lists is normally limited to the times when all the items are sentences. 
Punctuate the sentences as you would normally. Don’t use ending punctuation for phrases. If 
you absolutely cannot avoid mixing sentences and phrases, put a period after every item.  
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Do not use paragraphs as list items. A list is exactly that: a list of objects or short actions (for 
example, “Do this.”, “Adjust that.”, “Verify the settings.”). Paragraphs are part of the body 
text.  

In order to ensure that everyone uses the same type of bullet, and that the bullet is of 
reasonable size, do not use the automatic bullet feature in Word. (Turn off all of Word’s 
automatic formatting features before proceeding. See “Turning Off Auto-Formatting” on 
page 28.) To insert a bullet, follow these steps: 

Step 1. Place the cursor at the appropriate spot.  

Step 2. Ensure that the ‘Num Lock’ is on for the keypad.  

Step 3. While holding down the ALT key, type the number 0149 on the keypad (this 
won’t work with the number keys at the top of the keyboard). Then let go of 
the ALT key. The bullet character will appear.  

Step 4. Press the Tab key, and then type the text of the bullet item. 

 If you have a copy of the Compliance style template, use “List” for first-level bullets. Use 
“List 2” for second-level bullets, and use the en-dash for the bullet character. The ALT code 
for the en-dash is ALT 0150. Do not use a third level of bullets unless it’s unavoidable. 
However, before doing so, consider whether the list is constructed correctly. It may be 
possible to break it into multiple lists.   

If a bulleted list is very long—more than five items—or if it crosses the page boundary, it can 
sometimes be difficult to locate specific items. In this case, use lowercase letters for each 
item, rather than bullet characters. As much as possible, avoid creating multi-page lists. They 
are difficult to absorb because there are too many items.  

Numbered Lists 

Numbered lists are used to present list material when the order of the items is important, or to 
present sequential steps, such as a procedure. The rules for bulleted lists apply to numbered 
lists, as well.  

If a procedure has steps and substeps, use numbers for the steps and lowercase letters for the 
substeps, as shown in the example:  

Step 1. Open the peanut butter jar. 

a. Unscrew the lid. 

b. Remove the protective cover and discard it. 

As much as possible, avoid this type of construction. Instead, break each “step” out as a 
procedure, with each “substep” being a single step. 
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If a step in a procedure has a short list of items in it, use the bullet character mentioned above 
(ALT 0149) . Do not use more than one level of bullets as part of a procedural step. Example: 

Step 1. Ensure that you have all of the components: 

• Bread 

• Peanut butter 

• Jelly 

Because the automatic numbering feature can ‘break’* and create problems when files are 
opened on different computers, do not use the automatic numbering feature in Word. (Turn 
off all of Word’s automatic formatting features before proceeding. See “Turning Off Auto-
Formatting” on page 28.) Type the number, followed by a tab, and then the text of the item. 
If you have a copy of the Compliance style template, use “List” for a numbered list. Use 
“List 2” for a bulleted or lettered list that falls under an individual numbered item. Use 
“Step” for the first level of a procedural step; the word “Step” is added automatically by the 
style. Use “Substep” for a second-level procedural step.  

Word Choice 

In technical documents, it’s important to choose the right word and use it correctly. The 
words in the table below are in no particular order. They reflect issues that have been raised 
by project managers, or problems that were noted in some documents.  

 
affect  (action) vs. effect  
(outcome) 

“Will this change affect your plans?” “The final effect of the 
change is higher costs.”  Do not use effect as a verb.  

dispose of vs. dispose To discard or throw away: “Dispose of all wastes according to 
regulations.” “This waste must be disposed of in a waterproof 
container.” When used without of, dispose means to be inclined 
to do something.  

hazardous waste/material not “a” hazardous waste/material except when stating 
Compound XYZ is a hazardous material. 

assure vs. ensure vs. insure To assure means to declare earnestly; to ensure means to 
make certain; to insure means to guarantee against loss or 
harm. “I assure you, I ensured that your car is insured.”  

                                                 

* You type a list of items numbered 1, 2, and 3, followed by text, followed by another list numbered 1, 2, and 3. 
Later, you or someone else opens the file to discover that you now have items 1, 2, and 3, followed by text, 
followed by items 4, 5, and 6. 
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ensure that vs. ensure Follow ensure with that when you mean that an action must be 
verified: “Ensure that the drum is sealed before moving it.” Use 
ensure alone when you mean that a quality must be verified: 
“Ensure the integrity of the seal before moving the drum.”  

once vs. after After indicates sequence. Once indicates a single occurrence. 
“After the class is over, strike the bell once.”  

However However is often used to indicate a change in position or 
direction: “Dispose of the waste in a large box. However, if a 
box is not available, you may use a drum.” Note that there are 
two sentences here, not one sentence with a comma before 
however.  

compose, include, comprise, 
and constitute 

Compose indicates a complete list of components: “The site is 
composed of a concrete-block building, a small grassy area 
west of the building, an asphalt parking lot, and an asphalt 
driveway.”  

Includes (“The site includes a concrete-block building…”) 
generally indicates an incomplete list, so be careful when you 
use this verb.  

Comprise and constitute: The whole (the site) comprises 
(includes) the parts (building, etc.); the parts constitute (make 
up) the whole. The correct usage of comprise is “The site 
comprises a concrete-block building, a small grassy area west 
of the building, an asphalt parking lot, and an asphalt driveway.” 
It is never correct to say is comprised of. The correct usage of 
constitute is “A concrete-block building, a small grassy area 
west of the building, an asphalt parking lot, and an asphalt 
driveway constitute the site.”  

between vs. among Between is used when discussing relationships concerning two 
or more entities; among is used when there are three or more. 
Exception: use between with three or more entities when 
discussing the relationship of one to each of the others in turn. 

average vs. mean vs. median Average and mean both stand for the sum of the items divided 
by the number of items. Median stands for the number that is 
exactly in the middle of the list of items: half the numbers are 
higher than the median and half the numbers are lower.  

imply vs. infer Imply is an action of the speaker, meaning to pass on meaning 
or information without actually stating it (“He said that he didn’t 
cause the accident, but his tone implied that he knew who 
did.”).  

Infer is an action of the listener/reader, meaning to extract 
meaning that wasn’t explicitly stated (“From the complicated 
driving directions, she inferred that the site was extremely 
isolated from the main highways.”).  

since vs. because Since indicates occurrences after a particular point in time. 
Because indicates a reason. “Since last May, he’s been in a 
wheelchair. He can’t walk because he was injured in a car 
accident.”  
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can vs. may vs. might Can indicates ability. May gives permission. Might indicates a 
possibility that is not certain.  

shall (or must) vs. will vs. 
should 

Shall (or must)  indicates a requirement (“This type of 
hazardous waste shall be (must be) accumulated in a 
55-gallon, closed-head drum.”). Will indicates a future action (“I 
will leave at 10:00.”). Should indicates a suggestion (“You 
should check your car’s oil at least once each month.”).  

Shall is often used in legal documents. Must is more 
appropriate for our documents, unless the client specifies 
otherwise. Never use should when stating a requirement.  

less vs. fewer Less refers to amount or quantity (“Less than half of the fuel 
was contaminated.”). Fewer refers to number (“Reorder the 
filters when the stock on hand is fewer than four.”). Other 
examples: fewer people (the number of people), less work (the 
amount of work), fewer opportunities, less trouble [but fewer 
difficulties (refers to number of difficult things)].  

consists of vs. contains Consists of refers to ingredients: “Our training program consists 
of 40 hours of classroom instruction and 20 hours of hands-on 
instruction.” “Chocolate chip cookies consist of flour, sugar, 
eggs, milk, and lots & lots of chocolate chips.”   

Contains refers to what is held inside a container or area: “The 
box contains used batteries.” “Building 112 contains office 
space, toilet facilities, and a small weapons room.” 

lay vs. lie  Lay requires an object. Lie doesn’t. “Lay the hammer on the 
bench.”  “I am going to lie down for a nap.” Put is a synonym for 
lay. If the sentence doesn’t make sense when you use put, use 
lie.  

The past tense of lay is laid: “He laid the hammer on the 
bench.” The past tense of lie is lay: “He lay down for a nap.” 

which vs. that Which is nonrestrictive. It introduces nonessential information. 
“The mobile refueler, which is full, is ready to go.” The phrase 
which is full provides additional information, but the sentence 
will make sense without it. The phrase is set off by commas.  

That is restrictive. It introduces essential information. “The 
mobile refueler that SSgt. Sims will drive is still in the shop.” 
The phrase that SSgt. Sims will drive identifies a specific 
vehicle out of several. Without the phrase, we can’t identify 
which vehicle is under discussion.  

who vs. whom Who is a subject. “Who is driving that refueler?” Whom is a 
subject. “The shipping instruction say to deliver the package to 
whom?”  

When choosing words, keep in mind that “bigger” words don’t make for better writing. The 
reverse is usually true because such words sound stuffy or intimidate the reader. Don’t say 
utilize when use works just as well. Choose the simpler synonym to keep your writing 
accessible to everyone.  
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One Word or Two, or Hyphenated? 

The table below shows whether certain “problem” words should be used as one word, two 
words, or a hyphenated pair. In a few cases, a word is listed simply to show the correct 
spelling.  

 
Hyphenated (note: never put a 
hyphen after words ending in the 
suffix ly) 

One Word Two Words 

 aboveground  
 antifreeze  
 backup (noun, adj.) back up (action) 
 barbwire  
base-wide (adj.)   
 belowground  
 buildup (noun) build up (action) 
built-in   
by-product   
clean-up (adj.) cleanup (noun) clean up (action) 

 collocate – verb; to set or 
place together  

 combating  
 commingle  
cosmic-ray (adj.)  cosmic rays (noun) 
 deionize   
drop-off (adj./noun)  drop off (action) 
 downwind  
  flight line 
follow-up (adj.)  follow up (verb) 
  ground water 
hard-copy (adj.)  hard copy (noun) 
heavy-duty (adj.)   
 heavyweight (adj.)  
in-depth (adj.)  in depth (adv.) 
 kickoff (noun, adj.) kick off (verb) 
 landfill (noun)  
 landform (noun)  
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Hyphenated (note: never put a 
hyphen after words ending in the 
suffix ly) 

One Word Two Words 

  life span 
make-up (adj.) makeup (noun) make up (action) 
 multiuse  
 nonfilterable  
 nonflammable  
 nonhazardous  
 nonindustrial  
 offline (adj., adv.)  
off-load (action)   
off-site (adj.)  off site (location) 
 ongoing  
 online (adj., adv.)  
on-site (adj.)  on site (location) 
 overpack  
 payback (noun) pay back (action) 
 pickup (adj./noun) pick up (action) 
 predetermined  
 prefabricated  
 recirculate  
 reclose  
 recordkeeping  
 reestablish  
 regrade  
 reuse  
 runoff (noun)  
run-on (adj.)   
 sandpaper  
 semivolatiles  
 setup (noun, adj.) set up (action) 
  shelf life 
 sorbent  
stand-alone   
 standby  
 statewide  
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Hyphenated (note: never put a 
hyphen after words ending in the 
suffix ly) 

One Word Two Words 

  storm water 
 subsection  
 subsurface  
  surface water 
 takedown (noun, adj.) take down (verb) 
 tenfold  
turn-in (noun, adj.)   turn in (action) 
ultraviolet-ray (adj.)  ultraviolet rays (noun) 
 upright (adv.)  
 upwind  
walk-through (noun)   
 washrack (noun)  
 wastewater (noun)  
 workover  
x-ray (verb, adj.)  x rays (noun) 

Singular vs. Plural 

Words ending in –ful: make the root word plural (one bagful, two bagsful).  

Acronyms and decades: Do not use an apostrophe (six SQGs, not six SQG’s; the 90s, not the 
90’s). 

Latin words: memorandum (singular) and memoranda (plural); index (s.) and indices (pl.); 
appendix (s.) and appendices (pl.); data (s.) and data (pl.) [modern usage; see the dictionary 
for exceptions]. 

Compound words: For closed compound words, add s or es (as appropriate) to the end of the 
word. For hyphenated and open compound words, add the plural inflection to the element 
that changes in number: daughters-in-law, courts-martial, doctors of philosophy, masters of 
art. 

Abbreviations: Normally add s or es, but there are exceptions. For abbreviations with more 
than one period, add an apostrophe and an s: M.A.’s and Ph.D.’s. Certain abbreviations 
become plural by doubling the letter: One page is p. but two or more pages is pp. One note 
is n. but two or more notes is nn.  
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Chapter 4. MS Word Tips 

This section contains some tips on using MS Word more easily and/or more effectively. 
These tips work in Word 2000. If you’ve moved up to Word 2002, proceed carefully as 
some of the menu items and dialogue boxes may have changed. For more help with Word, 
try these online resources:  

http://www.mvps.org/word/index.html  

http://tutorials.beginners.co.uk/  

http://www.oootraining.com/QwikAndDirty/QwikAndDirtyWordWeb/qwikword.htm  

Find & Replace 

Word's Find & Replace feature is very powerful. In addition to handling text, it can find and 
replace special characters and styles, or some combination of the three. The image below 
shows the various ‘Find and Replace’ fields and menus that are mentioned in this section. 

 

To see the additional options, select ‘Replace...’ from Word’s ‘Edit’ menu (or press 
[Ctrl][h]). Look for the ‘More’ button in the lower left corner of the ‘Find and Replace’ box 
when it pops up. Click that button to see the various search options. (If the button says 
‘Less,’ then you can already see the search options.) 
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Put the cursor in the ‘Find’ or ‘Replace’ field, as appropriate, and then click the ‘Format’ 
button to see these options: Font, Paragraph, Tabs, Language, Frame, Style, Highlight. If you 
select one of these options for the ‘Find’ field without entering any text, Word will look for 
any text that has the attributes that you specified in the various dialogue boxes. If you select 
one of these options for the ‘Replace’ field without entering any text, Word will apply the 
attributes that you specified in the various dialogue boxes to any text that meets the search 
criteria.  

Here's an example: You want to replace the style Level 2 Head with Heading 2. (This is an 
example. You may not have these particular styles in your document.) With the cursor in the 
‘Find what:’ field, click the ‘Format’ button, and select ‘Style’ from the list. In the ‘Find 
Style’ dialogue box, select the style Level 2 Head and then click OK.  

Look at the ‘Find what:’ field in the ‘Find and Replace’ dialogue box. Under the field, you'll 
see ‘Style: Level 2 Head.’  

Now put the cursor in the ‘Replace’ field. Click the ‘Format’ button and select ‘Style’ from 
the list. In the ‘Replace Style’ dialogue box, select the style Heading 2 and then click OK.  

Look at the ‘Replace with:’ field in the ‘Find and Replace’ dialogue box. Under the field, 
you'll see ‘Style: Heading 2.’  

As long as you didn’t type any text in either field, Word is now ready to replace Level 2 
Head style with Heading 2 style in any paragraph it finds. Click the ‘Replace All’ button to 
do just that. If you want to decide on a case-by-case basis, click the ‘Find Next’ button to 
find the paragraphs with Level 2 Head applied and then decide whether to change each one. 

The process is similar for each ‘Format’ option. If you put text in the ‘Find and Replace’ 
fields, you’ll limit the change to only that specific text, and, in the case of the example, only 
if it’s in Level 2 Head style. 

Next to the ‘Format’ button, you can see the ‘Special’ button. When you click the ‘Special’ 
button, you'll see a list of 21 options. In addition to paragraph marks, tab characters, and 
fields, you can choose “wildcards” like any character, any digit, or any letter, as well as 
footnote marks, em- and en-dashes, non-breaking hyphens and spaces, graphics, and more.  

When you select one of these items, the special character appears in the field where you had 
placed the cursor. You can search and replace with special characters on their own, or in 
combination with specific text and/or format attributes. 

Turning Off Auto-formatting 

Some of Word’s auto-formatting features actually cause problems at times, especially when 
different users of the same document have different versions of Word. The steps below will 
help you turn off the features that “break” the formatting in e²M documents:  
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Step 1. On the menu bar at the top of the Word screen, click ‘Tools.’ 

Step 2. Select ‘AutoCorrect’ from the drop-down menu. 

Step 3. Click the ‘AutoFormat As You Type’ tab along the top of the pop-up window. 

Step 4. In the ‘Apply as you type’ section (see figure below), make sure the following 
items are turned off (if there is a checkmark in the box to the left of the item, 
click the box to remove it): 

• Headings 

• Borders 

• Tables 

• Automatic bulleted list 

• Automatic numbered lists 

 

Step 5. In the ‘Automatically as you type’ section (see figure above), make sure the 
following items are turned off: 

• Format beginning of list item like the one before it 

• Define styles based on your formatting 

Step 6. Click the ‘AutoFormat’ tab at the top of the pop-up window (see figure 
below).  
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Step 7. In the ‘Apply’ section, make sure the following items are turned off: 

• Headings 

• Lists 

• Automatic bulleted lists 

• Other paragraphs 

Step 8. Click ‘OK’ at the bottom of the pop-up window. 

Cross-References in Word Documents 

When you need to refer the reader to a topic on a specific page, don't type in the page number 
manually. Instead use cross-references. MS Word will figure out which page the item is on 
and supply the correct page number.  

Follow these steps to insert the bookmark: 

Step 1. Go to the form, table, or section that you want to refer to.  

Step 2. Select the desired caption or paragraph.  

Step 3. Pull down the ‘Insert’ menu and select ‘Bookmark.’ You’ll see the dialogue 
box that appears below: 
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 If there are any bookmarks already in the document, you will see them in the 
dialogue box, as shown in the figure.  

Step 4. In the ‘Bookmark name’ field, type a brief descriptive name for the 
bookmark; spaces are not allowed, so use underscores.  

Step 5. After you type the name, click the ‘Add’ button. The dialogue box will close 
and your bookmark will be ready to use.  

Follow these steps to insert the cross-reference: 

Step1. Go to the place in the text where you refer to the bookmarked item.  

Step 2. Put the cursor in the spot where you would normally put the hand-typed page 
number.  

Step 3. Pull down the ‘Insert’ menu again, but this time select ‘Cross-reference.’ You 
will see the dialogue box shown below: 

 

 (The ‘For which numbered item” list will contain different items in your 
document.) 
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Step 4. From the ‘Reference type’ drop-down menu, select ‘Bookmark.’  

 

Step 5. From the ‘Insert reference to’ drop-down menu, select ‘Page number.’ 

 

Step 6. Check the ‘Insert as hyperlink’ box if you want users to be able to jump 
directly to that spot in an online copy of the document. Leave the ‘Include 
above/below’ box unchecked.  
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Step 7. In the ‘For which bookmark’ list, click to select the desired bookmark.  

 

Step 8. Click the ‘Insert’ button. 

Your document now shows the correct page number for the cross-reference. (If you are using 
chapter-based page numbering but your style sheet doesn’t automatically add the chapter 
number to the page number, you will have to manually type the chapter number and a hyphen 
before the page number in the cross-reference.)  

To update any field references, select the paragraph where they appear and press the F9 key 
on your keyboard. (This update method works for any kind of inserted field, including TOCs 
and indexes.) To update all the fields in the entire file, select all text (type [Control][a]) and 
then press F9. Be sure to do this before you print so that all the page references are up to 
date. 

“Hide” Graphics for Faster Scrolling 

Some company documents are very graphic-heavy. Word’s scroll speed slows down 
considerably when it has to keep redrawing the pictures as they go by. If this is a problem for 
you, tell Word to use picture placeholders instead:  

Step 1. From the ‘Tools’ menu, choose ‘Options.’  

Step 2. In the dialogue box, click the ‘View’ tab.  
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Step 3. In the ‘Show’ section,  make sure there is a checkmark in the ‘Picture 
Placeholders’ check box (click in the box).  

 
Step 4. Click OK.  

Now Word will display empty boxes where the images are inserted. The images are still 
there, and they will print. They just don’t appear on the screen, and Word will scroll much 
faster. Any new images that you insert from this point will also show up as empty boxes. To 
view them without printing, select ‘Print Preview’ from the ‘File’ menu, or go back to 
‘Options’ and uncheck the ‘Picture Placeholders’ check box. 

Using Page Boundaries  

In all versions of Word, you can click the Standard toolbar's Show/Hide  button to view 
paragraph markers to help you identify bad breaks or unnecessary blank lines. Unfortunately, 
seeing paragraph markers doesn’t help much when your document uses a variety of margin 
settings and contains both single and multi-column text. That’s where Word 2000’s Text 
Boundaries feature comes in. To view page boundaries, follow these steps: 
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Step 1. From the ‘Tools’ menu, select ‘Options.’  

Step 2. In the resulting dialogue box, click the ‘View’  tab. In the ‘Print And Web 
Layout Options’ section, select the ‘Text  Boundaries’ check box.  

 
Step 3. Click OK. 

Word 2000 now displays a dotted line that identifies page margins, columns, and other 
objects. This line is visible only in the Web Layout or Print Layout views; it doesn't appear 
on printed pages. 

Accent Characters from the Keyboard 

To add accent characters to the appropriate letters from the keyboard, use these shortcuts:  

• To add an acute accent (´) to a letter, press [Ctrl]['] (that’s [Ctrl] and the apostrophe), 
followed by the letter (for example, é).  

• To add a grave accent (`) to a letter, press [Ctrl][`] (the apostrophe under the tilde), 
followed by the letter (for example, è).  

• To add a tilde to a letter, press [Ctrl][Shift][~], followed by the letter (for example, ñ).  

• To add a circumflex (ˆ) to a letter, press [Ctrl][Shift][^], followed by the letter (for 
example, â).  

• To add a dieresis (¨) to a letter, press [Ctrl][Shift][:] (the colon), followed by the letter 
(for example, ü). 

Word adds the accent characters only to those characters that use them. For example, if you 
press [Ctrl]['] and type z or Z, Word will ignore the first keystroke because Z doesn’t use any 
accent characters. 
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Accent Characters Using ALT Codes 

Some accent characters can be typed by themselves, without a letter, directly from the 
keyboard, such as the tilde (~) and the circumflex (^). However, the others cannot. You can 
type those characters, or the letters that use them, by using ALT codes. To do this, hold down 
the ALT key while typing the appropriate four-digit code on the keypad at the right side of 
the keyboard (this won’t work using the number keys at the top). The table below provides 
the codes for various accent characters and accented letters, as well as some other useful 
symbols. 

sorted by symbol sorted by code 
Symbol Code  Code Symbol 
~ 0126  0126 ~ 
€ 0128  0128 € 
… 0133  0133 … 
ˆ 0136  0136 ˆ 
™ 0153  0153 ™ 
¡ 0161  0161 ¡ 
¢ 0162  0162 ¢ 
£ 0163  0163 £ 
¥ 0165  0165 ¥ 
¨ 0168  0168 ¨ 
© 0169  0169 © 
® 0174  0174 ® 
° 0176  0176 ° 
± 0177  0177 ± 
² 0178  0178 ² 
³ 0179  0179 ³ 
µ 0181  0181 µ 
¸ 0184  0184 ¸ 
º 0186  0186 º 
¿ 0191  0191 ¿ 
À 0192  0192 À 
Á 0193  0193 Á 
Â 0194  0194 Â 
Ã 0195  0195 Ã 
Ä 0196  0196 Ä 
Å 0197  0197 Å 
Æ 0198  0198 Æ 
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sorted by symbol sorted by code 
Symbol Code  Code Symbol 
Ç 0199  0199 Ç 
È 0200  0200 È 
É 0201  0201 É 
Ê 0202  0202 Ê 
Ë 0203  0203 Ë 
Ì 0204  0204 Ì 
Í 0205  0205 Í 
Î 0206  0206 Î 
Ï 0207  0207 Ï 
Ñ 0209  0209 Ñ 
Ò 0210  0210 Ò 
Ó 0211  0211 Ó 
Ô 0212  0212 Ô 
Õ 0213  0213 Õ 
Ö 0214  0214 Ö 
Ø 0216  0216 Ø 
Ù 0217  0217 Ù 
Ú 0218  0218 Ú 
Û 0219  0219 Û 
Ü 0220  0220 Ü 
Ý 0221  0221 Ý 
ß 0223  0223 ß 
à 0224  0224 à 
á 0225  0225 á 
â 0226  0226 â 
ã 0227  0227 ã 
ä 0228  0228 ä 
å 0229  0229 å 
æ 0230  0230 æ 
ç 0231  0231 ç 
è 0232  0232 è 
é 0233  0233 é 
ê 0234  0234 ê 
ë 0235  0235 ë 
ì 0236  0236 ì 
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sorted by symbol sorted by code 
Symbol Code  Code Symbol 
í 0237  0237 í 
î 0238  0238 î 
ï 0239  0239 ï 
ñ 0241  0241 ñ 
ò 0242  0242 ò 
ó 0243  0243 ó 
ô 0244  0244 ô 
õ 0245  0245 õ 
ö 0246  0246 ö 
ø 0248  0248 ø 
ù 0249  0249 ù 
ú 0250  0250 ú 
û 0251  0251 û 
ü 0252  0252 ü 
ý 0253  0253 ý 
ÿ 0255  0255 ÿ 
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